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Using	Help
Conventions
Navigating	Help
Searching	Help
Printing	Help	File	Topics



Conventions
This	help	file	uses	the	following	formatting	and	typographical
conventions:
» The	»	symbol	leads	you	through	nested	menu	items	and	dialog	box	options	to	a	final

action.	The	sequence	File»Page	Setup»Options	directs	you	to	pull	down	the	File	menu,
select	the	Page	Setup	item,	and	select	Options	from	the	last	dialog	box.
This	icon	denotes	a	note,	which	alerts	you	to	important	information.

bold Bold	text	denotes	items	that	you	must	select	or	click	in	the	software,	such	as	menu	items
and	dialog	box	options.	Bold	text	also	denotes	parameter	names.

green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,	help	file,	or	Web	address.

italic Italic	text	denotes	variables,	emphasis,	cross–references,	or	an	introduction	to	a	key
concept.	Italic	text	also	denotes	text	that	is	a	placeholder	for	a	word	or	value	that	you	must
supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should	enter	from	the	keyboard,
sections	of	code,	programming	examples,	and	syntax	examples.	This	font	is	also	used	for
the	proper	names	of	disk	drives,	paths,	directories,	programs,	subprograms,	subroutines,
device	names,	functions,	operations,	variables,	filenames,	and	extensions.



Navigating	Help	(Windows	Only)
To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to
the	left	of	this	window	or	use	the	following	toolbar	buttons	located	above
the	tabs:

Hide—Hides	the	navigation	pane	from	view.
Locate—Locates	the	currently	displayed	topic	in	the	Contents	tab,
allowing	you	to	view	related	topics.
Back—Displays	the	previously	viewed	topic.
Forward—Displays	the	topic	you	viewed	before	clicking	the	Back
button.
Options—Displays	a	list	of	commands	and	viewing	options	for	the
help	file.



Searching	Help	(Windows	Only)
Use	the	Search	tab	to	the	left	of	this	window	to	locate	content	in	this	help
file.	If	you	want	to	search	for	words	in	a	certain	order,	such	as	"related
documentation,"	add	quotation	marks	around	the	search	words	as	shown
in	the	example.	Searching	for	terms	on	the	Search	tab	allows	you	to
quickly	locate	specific	information	and	information	in	topics	that	are	not
included	on	the	Contents	tab.



Wildcards
You	also	can	search	using	asterisk	(*)	or	question	mark	(?)	wildcards.
Use	the	asterisk	wildcard	to	return	topics	that	contain	a	certain	string.	For
example,	a	search	for	"prog*"	lists	topics	that	contain	the	words
"program,"	"programmatically,"	"progress,"	and	so	on.
Use	the	question	mark	wildcard	as	a	substitute	for	a	single	character	in	a
search	term.	For	example,	"?ext"	lists	topics	that	contain	the	words
"next,"	"text,"	and	so	on.

Note		Wildcard	searching	will	not	work	on	Simplified	Chinese,	Traditional	Chinese,	Japanese,
and	Korean	systems.



Nested	Expressions
Use	nested	expressions	to	combine	searches	to	further	refine	a	search.
You	can	use	Boolean	expressions	and	wildcards	in	a	nested	expression.
For	example,	"example	AND	(program	OR	VI)"	lists	topics	that	contain
"example	program"	or	"example	VI."	You	cannot	nest	expressions	more
than	five	levels.



Boolean	Expressions
Click	the	 	button	to	add	Boolean	expressions	to	a	search.	The	following
Boolean	operators	are	available:

AND	(default)—Returns	topics	that	contain	both
search	terms.	You	do	not	need	to	specify	this
operator	unless	you	are	using	nested
expressions.
OR—Returns	topics	that	contain	either	the	first
or	second	term.
NOT—Returns	topics	that	contain	the	first	term
without	the	second	term.
NEAR—Returns	topics	that	contain	both	terms
within	eight	words	of	each	other.



Search	Options
Use	the	following	checkboxes	on	the	Search	tab	to	customize	a	search:

Search	previous	results—Narrows	the	results	from	a	search	that
returned	too	many	topics.	You	must	remove	the	checkmark	from
this	checkbox	to	search	all	topics.
Match	similar	words—Broadens	a	search	to	return	topics	that
contain	words	similar	to	the	search	terms.	For	example,	a	search
for	"program"	lists	topics	that	include	the	words	"programs,"
"programming,"	and	so	on.
Search	titles	only—Searches	only	in	the	titles	of	topics.



Printing	Help	File	Topics	(Windows	Only)
Complete	the	following	steps	to	print	an	entire	book	from	the	Contents
tab:

1.	 Right-click	the	book.
2.	 Select	Print	from	the	shortcut	menu	to	display	the	Print	Topics

dialog	box.
3.	 Select	the	Print	the	selected	heading	and	all	subtopics	option.

Note		Select	Print	the	selected	topic	if	you	want	to	print
the	single	topic	you	have	selected	in	the	Contents	tab.

4.	 Click	the	OK	button.



Printing	PDF	Documents
This	help	file	may	contain	links	to	PDF	documents.	To	print	PDF
documents,	click	the	print	button	located	on	the	Adobe	Acrobat	Viewer
toolbar.



PXI	System	Configuration
Configuring	your	PXI	system	requires	two	steps:	identifying	the	PXI
system	controller	and	identifying	any	PXI	chassis.	You	must	configure
your	PXI	system	to	allow	geographic	addressing	(such	as	chassis	and
slot	numbering)	of	your	PXI	devices.
Identifying_the_PXI_System
Identifying_a_PXI_Chassis
Identifying	a	PXI	Chassis	Connected	by	a	Third-Party	Bridge
Renumbering	a	Chassis
Deleting	Identifications
Configuring	PXI	Triggers
Configuring	the	SCXI	Subsystem	of	a	PXI	Chassis



Identifying	the	PXI	System
Your	PXI	system	starts	in	a	nonconfigured	state.	When	you	expand
Devices	&	Interfaces	in	MAX	for	the	first	time,	you	should	see	your	PXI
system	represented	as	PXI	System	(Unidentified),	except	on	a	PXI
Express	system,	where	it	should	be	auto-identified.
To	identify	your	PXI	system	controller,	right-click	PXI	System	and	choose
the	appropriate	PXI	controller	model	from	the	device	list	in	the	Identify
As»	menu.	If	your	PXI	System	uses	a	remote	controller	(that	is,	the	PXI
system	controller	is	a	PC),	select	External	PC.	If	the	controller	model	is
not	listed,	select	Other...	and	browse	for	the	controller.ini	file	that
contains	the	appropriate	information	for	your	PXI	controller.

Note		If	you	do	not	have	PXI	in	your	system,	your	PXI	system	will	be	empty,	and	you	can
identify	your	PXI	system	controller	as	an	external	PC.	Right-click	PXI	System	and	choose
External	PC.	If	you	extend	your	computer	later	with	a	PXI	chassis	via	a	PCI-to-PCI	bridging
solution	such	as	a	National	Instruments	MXI-4	bridge,	you	can	configure	your	PXI	system	and
devices	then.



Identifying	a	PXI	Chassis
MAX	supports	single-chassis	or	multiple-chassis	configurations,	and	you
must	identify	each	chassis	separately.
When	using	a	National	Instruments	system	controller	(remote	or
embedded),	all	connected	PXI	chassis	are	detected	and	displayed	in	the
configuration	tree	under	the	PXI	system	node.	Some	chassis	are	in
nonconfigured	state	by	default	and	must	be	identified,	while	the	PXI
software	auto-identifies	other	chassis	(including	all	PXI	Express	chassis).
To	identify	a	PXI	chassis,	right-click	Chassis	(Unidentified)	and	choose
the	appropriate	chassis	type	from	the	chassis	list	in	the	Identify	As»
menu.	You	can	also	identify	a	PXI	chassis	by	selecting	the	chassis	and
the	appropriate	chassis	type	from	the	drop-down	menu	in	the	Slot	View
in	the	right	pane.
After	a	chassis	is	identified,	MAX	assigns	the	first	available	number
starting	from	1	to	the	chassis.	You	can	renumber	the	chassis	after	it	has
been	identified	by	right-clicking	the	chassis	and	choosing	Renumber.



Identifying	a	PXI	Chassis	Connected	by	a	Third-Party
Bridge
If	your	PXI	system	uses	a	third-party	bridging	solution,	MAX	cannot
detect	the	presence	of	a	PXI	chassis	automatically.	To	identify	a	PXI
chassis	connected	by	a	third-party	bridge,	complete	the	following	steps.

1.	 Right-click	the	PXI	System	node	(such	as	PXI	System	(...))	and
select	Show	PXI	Buses.	Every	PXI/PCI	bus	should	now	be
displayed	underneath	your	PXI	system.

2.	 Find	the	PXI	bus	node	that	represents	the	bus	segment	used	for
your	PXI	chassis	backplane.	If	the	missing	PXI	chassis	spans
multiple	buses,	select	the	bus	that	represents	the	first	segment	of
that	chassis	backplane.	Right-click	the	PXI	bus	and	select
Identify	Bus	as	Chassis	to	create	a	new	nonconfigured	chassis
for	the	PXI	bus.	Follow	the	procedures	in	Identifying	a	PXI
Chassis	to	identify	this	new	nonconfigured	PXI	chassis.

You	can	hide	the	PXI	bus	objects	again	by	right-clicking	the	PXI	System
node	and	selecting	Show	PXI	Buses	to	uncheck	the	option.	By	default,
MAX	does	not	show	PXI	buses	in	your	PXI	system.



Renumbering	a	Chassis
In	MAX,	right-click	the	chassis	you	want	to	renumber	and	select
Renumber.	In	the	dialog,	enter	a	new	chassis	number	from	0	to	1024
that	does	not	conflict	with	other	chassis	numbers	in	the	PXI	system.



Deleting	Identifications
Right-click	the	PXI	System	node	(such	as	PXI	System	(...))	in	the
configuration	tree	and	select	Remove	All	Identifications.	If	you	accept
the	pop-up	warning,	the	PXI	system	reverts	to	a	nonconfigured	state.
Follow	the	procedures	in	Identifying	the	PXI	System	and	Identifying	a	PXI
Chassis	to	reconfigure	your	PXI	system.



Configuring	PXI	Triggers
You	can	reserve	trigger	lines	in	your	National	Instruments	PXI	system	to
prevent	software	that	uses	National	Instruments	components	from	using
certain	lines.	You	may	need	to	reserve	trigger	lines	when	you	have	a	PXI
device	that	uses	predetermined	triggers.	For	more	information	about	why
trigger	reservation	may	be	necessary,	see	What	is	Trigger	Reservation,
and	Why	is	it	Necessary?	To	reserve	triggers	in	a	PXI	chassis,	complete
the	following	steps:

1.	 Configure	your	PXI	system	by	following	the	procedures	in
Identifying	the	PXI	System	and	Identifying	a	PXI	Chassis.

2.	 Select	the	PXI	chassis	node	that	contains	the	trigger	lines	you
want	to	reserve.	In	the	right	pane,	select	the	Triggers	tab,	which
displays	a	checkbox	for	each	trigger	line	in	your	chassis.

3.	 Check	each	line	you	want	to	reserve	and	click	Save	to	apply	and
save	your	changes.

For	more	detailed	information,	see	KnowledgeBase	3TJDOND8:	Using
PXI	Timing	and	Triggering	Functionality.
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What	Are	PXI	Triggers?
PXI	triggers	are	signals	that	are	often	used	to	synchronize	events
between	devices	in	a	chassis.	These	signals	are	asserted	or	de-asserted
by	devices	in	the	chassis	and	are	passed	to	other	devices	through	trigger
lines	on	the	backplane	of	the	chassis.	Each	trigger	bus	on	a	chassis
backplane	contains	eight	PXI	trigger	lines	(PXI_Trig0	through	PXI_Trig7).
Each	slot	in	a	PXI	chassis	is	connected	to	a	single	trigger	bus	and	can
transmit	and	receive	signals	over	the	trigger	lines	from	any	other	device
on	the	same	bus.	Most	chassis	contain	only	a	single	trigger	bus,	but
some	chassis,	such	as	the	NI	PXI-1045,	have	multiple	trigger	buses.



Chassis	with	a	Single	Trigger	Bus
In	chassis	containing	only	a	single	bus,	all	slots	share	the	same	trigger
bus	and	can	communicate	to	each	other	using	this	bus.	For	example,	the
NI	PXI-1042	chassis	has	one	trigger	bus,	and	all	slots	(1-8)	reside	on	this
trigger	bus.	In	this	situation,	a	device	in	any	slot	can	use	the	backplane	to
send	triggers	to	a	device	in	any	other	slot.



Chassis	with	Multiple	Trigger	Buses
Normally,	if	a	chassis	has	more	than	one	trigger	bus,	a	device	in	a	slot
connected	to	one	trigger	bus	cannot	use	the	trigger	lines	to	communicate
to	a	device	connected	to	another	trigger	bus	in	the	same	chassis.	For
example,	the	NI	PXI-1045	chassis	has	18	slots	and	three	trigger	buses.
In	this	chassis	the	slots	are	assigned	to	the	trigger	buses	as	follows:
trigger	bus	1:	slots	1-6;	trigger	bus	2:	slots	7-12;	and	trigger	bus	3:	slots
13-18.	Without	further	configuration,	the	NI	PXI-1045	trigger	buses
function	like	three	separate	single-segment	chassis.

Note		Some	multibus	chassis	such	as	the	NI	PXI-1045	can	forward	trigger	signals	between
buses.	Many	National	Instruments	products	such	as	NI-DAQmx	will,	when	necessary,
dynamically	route	trigger	signals	between	the	separate	trigger	buses	in	these	chassis.	Routes
can	also	be	statically	configured	for	compatibility	with	legacy	programs	using	the	chassis'
Triggers	pane	in	MAX.

Note		Refer	to	the	KnowledgeBase	article	32GFMIWD,	Routing	PXI	Trigger	Lines	Across	the
Buses	of	Multisegment	PXI	Chassis,	to	learn	more	about	trigger	routing	in	multisegment	PXI
chassis.
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What	Is	Trigger	Reservation,	and	Why	Is	It	Necessary?
If	multiple	devices	attempt	to	use	the	same	trigger	line	simultaneously,
hardware	damage	can	occur.	Beginning	with	LabVIEW	7.0,	NI-DAQmx
7.0,	and	NI-VISA	3.0,	National	Instruments	software	can	track	which	lines
the	hardware	is	using	and	automatically	use	any	available	trigger	lines;
however,	trigger	lines	used	by	components	from	another	vendor	or	old
software	cannot	be	tracked	automatically	by	National	Instruments
software.	By	reserving	a	trigger	line	in	MAX,	you	can	tell	National
Instruments	software	that	a	particular	trigger	line	is	in	use.



Manually	Reserving	Triggers	in	MAX
Use	MAX	to	maintain	trigger	reservations	for	each	of	your	PXI	chassis.
By	expanding	an	entire	identified	PXI	System	under	Devices	and
Interfaces,	you	can	see	all	the	chassis	in	your	system.	To	change	and
view	each	chassis'	static	trigger	reservations,	follow	these	steps:

1.	 Under	Devices	and	Interfaces,	select	the	chassis	containing	the
trigger	lines	you	want	to	reserve.

2.	 Select	the	Triggers	tab	in	the	right	pane.
3.	 Check	the	trigger	lines	you	want	to	reserve.
4.	 Click	the	Save	button	to	apply	and	save	your	changes.

After	saving	the	settings,	any	lines	selected	to	be	statically	reserved	will
not	be	used	by	current	National	Instruments	components,	so	legacy
components	or	third-party	components	can	safely	use	the	lines.



Programmatically	Reserving	Triggers	in	VISA
Programmatically	reserving	triggers	is	possible	using	NI-VISA	3.0	and
later	on	a	per-instrument	basis.	After	opening	a	VISA	session	to	a	PXI
INSTR	resource,	you	can	reserve	a	trigger	line	on	the	trigger	bus
connected	to	the	device.	Additionally,	trigger	routing	and	reservation	is
available	through	a	PXI	BACKPLANE	resource,	which	is	available	in	NI-
VISA	3.1	and	later.	For	more	information,	refer	to	your	NI-VISA
documentation.



Configuring	the	SCXI	Subsystem	of	a	PXI	Chassis
For	a	PXI/SCXI	combination	chassis,	such	as	the	PXI-1050	or	PXI-1052,
you	must	also	configure	the	chassis	for	use	with	NI-DAQ.	For	NI-DAQmx,
right-click	Devices	and	Interfaces»NI-DAQmx	Devices	and	choose
Create	New	NI-DAQmx	Device»NI-DAQmx	SCXI	Chassis.	After
selecting	the	appropriate	chassis,	follow	the	instructions	provided.	For
traditional	NI-DAQ,	right-click	Devices	and	Interfaces»Traditional	NI-
DAQ	Devices	and	choose	Add	SCXI	Chassis...,	selecting	the
appropriate	chassis.



Remote	PXI	System	Configuration
Remote	PXI	system	configuration	is	similar	to	configuring	your	local	PXI
system.	First,	install	PXI	Services	on	your	RT	target	(refer	to
Downloading	Software	for	information	on	how	to	update	your	software).
Once	the	RT	target	has	been	updated	and	rebooted,	expand	Devices	&
Interfaces	under	your	RT	target	and	follow	the	procedures	in	Identifying
the	PXI	System	and	Identifying	a	PXI	Chassis.

Note		To	learn	more	about	configuring	a	LabVIEW	Real-Time	system,	refer	to	the	LabVIEW
Real-Time	Target	Configuration	Tutorial	in	MAX	at	Help»Help	Topics»Remote	Systems»MAX
Remote	Systems	Help»LabVIEW	Real-Time	Target	Configuration.

MAXRmEng.chm::/html/tutorial.html


PXI	Basics
PXI	System	Basics
PXI	Chassis	Basics
PXI	Bus	Basics



PXI	System	Basics
How	do	I	use	MAX	with	my	PXI	system?
The	PXI	system	shows	a	hierarchy	of	all	PXI	chassis	and	PXI	devices	in
your	system.	You	can	use	MAX	to	configure	your	PXI	system	by
identifying	what	type	of	controller	you	are	using	and	each	chassis	in	your
system.	If	you	have	a	desktop	PC	connected	to	a	PXI	chassis	via	a	PCI-
to-PCI	bridging	solution	such	as	a	National	Instruments	MXI-4	bridge,
you	must	identify	your	PXI	system	controller	as	an	external	PC.



What	if	I	don't	have	PXI	in	my	system?
For	desktop	PCs	not	connected	to	a	PXI	chassis,	your	PXI	system	will	be
empty,	and	you	can	identify	your	PXI	system	controller	as	an	external
PC.	If	you	extend	your	computer	later	with	a	PXI	chassis	via	a	PCI-to-PCI
bridging	solution	such	as	a	National	Instruments	MXI-4	bridge,	you	can
configure	your	PXI	system	and	devices	then.



What	can	I	do	at	the	PXI	system	level?
You	can	identify	your	PXI	system	controller,	communicate	with	devices,
delete	all	identifications,	or	show	hidden	PXI	buses	in	your	system.



What	do	you	want	to	do?
	Identify	my	PXI	system	controller
	Communicate	with	my	device
	Delete	all	identifications
	Show	PXI	buses
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PXI	Chassis	Basics
How	do	I	use	MAX	with	my	PXI	chassis?
To	configure	your	PXI	system,	you	must	identify	each	PXI	chassis.	(PXI
Express	chassis	are	automatically	identified.)	Identifying	your	chassis
enables	features	such	as	slot	identification,	geographic	addressing,	and
trigger	routing.	MAX	automatically	detects	all	PXI	chassis	connected	by
National	Instruments	MXI	bridging	kits,	but	cannot	detect	the	PXI	chassis
model.
For	third-party	bridging	solutions,	you	must	show	PXI	buses	at	the	PXI
system	level	to	see	the	bus	that	represents	the	chassis.	Then	you	must
create	a	chassis	for	that	bus.	Refer	to	PXI	System	Basics	and	PXI	Bus
Basics	for	more	information.



What	can	I	do	at	the	PXI	chassis	level?
You	can	identify	your	PXI	chassis	type,	view	and	communicate	with
devices,	renumber	the	chassis,	delete	the	chassis,	and	reserve	triggers
in	the	chassis.



What	do	you	want	to	do?
	Identify	my	PXI	chassis
	View	and	communicate	with	my	device
	Renumber	my	PXI	chassis
	Delete	my	PXI	chassis
	Configure	triggers	in	my	PXI	chassis
	Configure	my	SCXI	subsystem
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PXI	Bus	Basics
How	do	I	use	MAX	with	my	PXI	buses?
PXI	buses	represent	the	internal	PCI-to-PCI	bridge	hierarchy	for	your	PXI
system.	The	configuration	tree	represents	the	buses,	using	information
about	which	buses	are	subordinates	of	other	buses.	Any	bus	identified	as
a	chassis	(such	as	a	chassis	connected	by	National	Instruments	MXI
bridging	solutions)	is	now	shown	as	a	chassis,	rather	than	a	bus.	You
must	identify	third-party	PCI-to-PCI	bridges	that	connect	to	PXI	chassis
before	configuring	the	chassis.	You	may	see	other	PXI	buses	in	your	PXI
system.	These	buses	are	PCI-to-PCI	bridges	internal	to	your	computer	or
bridges	on	multifunction	devices,	and	should	not	be	identified	as	chassis.



What	can	I	do	at	the	PXI	bus	level?
You	can	identify	your	PXI	bus	as	a	chassis.



What	do	you	want	to	do?
	Identify	my	PXI	bus	as	a	chassis
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Troubleshooting
Why	do	my	VISA	instruments	have	"Unknown"	chassis	and	slot
numbers?
You	have	not	properly	configured	your	PXI	system.	You	must	correctly
identify	the	PXI	system	controller	and	chassis	type	before	geographic
addressing	such	as	chassis	and	slot	number	is	enabled.	Follow	the
procedures	in	Identifying	the	PXI	System	and	Identifying	a	PXI	Chassis	to
correctly	configure	your	PXI	system.
Why	is	my	PXI	system	"Unidentified"?
You	have	not	properly	configured	your	PXI	system.	Refer	to	Identifying
the	PXI	System	to	correctly	configure	your	PXI	system.



Important	Information
Warranty
Copyright
Trademarks
Patents
Warning	Regarding	Use	of	NI	Products



Warranty
The	media	on	which	you	receive	National	Instruments	software	are
warranted	not	to	fail	to	execute	programming	instructions,	due	to	defects
in	materials	and	workmanship,	for	a	period	of	90	days	from	date	of
shipment,	as	evidenced	by	receipts	or	other	documentation.	National
Instruments	will,	at	its	option,	repair	or	replace	software	media	that	do	not
execute	programming	instructions	if	National	Instruments	receives	notice
of	such	defects	during	the	warranty	period.	National	Instruments	does	not
warrant	that	the	operation	of	the	software	shall	be	uninterrupted	or	error
free.
A	Return	Material	Authorization	(RMA)	number	must	be	obtained	from
the	factory	and	clearly	marked	on	the	outside	of	the	package	before	any
equipment	will	be	accepted	for	warranty	work.	National	Instruments	will
pay	the	shipping	costs	of	returning	to	the	owner	parts	which	are	covered
by	warranty.
National	Instruments	believes	that	the	information	in	this	document	is
accurate.	The	document	has	been	carefully	reviewed	for	technical
accuracy.	In	the	event	that	technical	or	typographical	errors	exist,
National	Instruments	reserves	the	right	to	make	changes	to	subsequent
editions	of	this	document	without	prior	notice	to	holders	of	this	edition.
The	reader	should	consult	National	Instruments	if	errors	are	suspected.
In	no	event	shall	National	Instruments	be	liable	for	any	damages	arising
out	of	or	related	to	this	document	or	the	information	contained	in	it.
EXCEPT	AS	SPECIFIED	HEREIN,	NATIONAL	INSTRUMENTS	MAKES
NO	WARRANTIES,	EXPRESS	OR	IMPLIED,	AND	SPECIFICALLY
DISCLAIMS	ANY	WARRANTY	OF	MERCHANTABILITY	OR	FITNESS
FOR	A	PARTICULAR	PURPOSE.	CUSTOMER'S	RIGHT	TO	RECOVER
DAMAGES	CAUSED	BY	FAULT	OR	NEGLIGENCE	ON	THE	PART	OF
NATIONAL	INSTRUMENTS	SHALL	BE	LIMITED	TO	THE	AMOUNT
THERETOFORE	PAID	BY	THE	CUSTOMER.	NATIONAL
INSTRUMENTS	WILL	NOT	BE	LIABLE	FOR	DAMAGES	RESULTING
FROM	LOSS	OF	DATA,	PROFITS,	USE	OF	PRODUCTS,	OR
INCIDENTAL	OR	CONSEQUENTIAL	DAMAGES,	EVEN	IF	ADVISED	OF
THE	POSSIBILITY	THEREOF.	This	limitation	of	the	liability	of	National
Instruments	will	apply	regardless	of	the	form	of	action,	whether	in



contract	or	tort,	including	negligence.	Any	action	against	National
Instruments	must	be	brought	within	one	year	after	the	cause	of	action
accrues.	National	Instruments	shall	not	be	liable	for	any	delay	in
performance	due	to	causes	beyond	its	reasonable	control.	The	warranty
provided	herein	does	not	cover	damages,	defects,	malfunctions,	or
service	failures	caused	by	owner's	failure	to	follow	the	National
Instruments	installation,	operation,	or	maintenance	instructions;	owner's
modification	of	the	product;	owner's	abuse,	misuse,	or	negligent	acts;
and	power	failure	or	surges,	fire,	flood,	accident,	actions	of	third	parties,
or	other	events	outside	reasonable	control.



Copyright
Under	the	copyright	laws,	this	publication	may	not	be	reproduced	or
transmitted	in	any	form,	electronic	or	mechanical,	including	photocopying,
recording,	storing	in	an	information	retrieval	system,	or	translating,	in
whole	or	in	part,	without	the	prior	written	consent	of	National	Instruments
Corporation.
National	Instruments	respects	the	intellectual	property	of	others,	and	we
ask	our	users	to	do	the	same.	NI	software	is	protected	by	copyright	and
other	intellectual	property	laws.	Where	NI	software	may	be	used	to
reproduce	software	or	other	materials	belonging	to	others,	you	may	use
NI	software	only	to	reproduce	materials	that	you	may	reproduce	in
accordance	with	the	terms	of	any	applicable	license	or	other	legal
restriction.



Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks	of
National	Instruments	Corporation.	Refer	to	the	Terms	of	Use	section	on
ni.com/legal	for	more	information	about	National	Instruments	trademarks.
FireWire®	is	the	registered	trademark	of	Apple	Computer,	Inc.
Handle	Graphics®,	MATLAB®,	Real-Time	Workshop®,	Simulink®,
Stateflow®,	and	xPC	TargetBox®	are	registered	trademarks,	and
TargetBox™	and	Target	Language	Compiler™	are	trademarks	of	The
MathWorks,	Inc.
Tektronix®	and	Tek	are	registered	trademarks	of	Tektronix,	Inc.
Other	product	and	company	names	mentioned	herein	are	trademarks	or
trade	names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program	are
business	entities	independent	from	National	Instruments	and	have	no
agency,	partnership,	or	joint-venture	relationship	with	National
Instruments.

javascript:WWW(WWW_Trademark)


Patents
For	patents	covering	National	Instruments	products,	refer	to	the
appropriate	location:	Help»Patents	in	your	software,	the	patents.txt	file
on	your	CD,	or	ni.com/patents.

javascript:WWW(WWW_Patents)


WARNING	REGARDING	USE	OF	NATIONAL	INSTRUMENTS
PRODUCTS
(1)	NATIONAL	INSTRUMENTS	PRODUCTS	ARE	NOT	DESIGNED
WITH	COMPONENTS	AND	TESTING	FOR	A	LEVEL	OF	RELIABILITY
SUITABLE	FOR	USE	IN	OR	IN	CONNECTION	WITH	SURGICAL
IMPLANTS	OR	AS	CRITICAL	COMPONENTS	IN	ANY	LIFE	SUPPORT
SYSTEMS	WHOSE	FAILURE	TO	PERFORM	CAN	REASONABLY	BE
EXPECTED	TO	CAUSE	SIGNIFICANT	INJURY	TO	A	HUMAN.
(2)	IN	ANY	APPLICATION,	INCLUDING	THE	ABOVE,	RELIABILITY	OF
OPERATION	OF	THE	SOFTWARE	PRODUCTS	CAN	BE	IMPAIRED	BY
ADVERSE	FACTORS,	INCLUDING	BUT	NOT	LIMITED	TO
FLUCTUATIONS	IN	ELECTRICAL	POWER	SUPPLY,	COMPUTER
HARDWARE	MALFUNCTIONS,	COMPUTER	OPERATING	SYSTEM
SOFTWARE	FITNESS,	FITNESS	OF	COMPILERS	AND
DEVELOPMENT	SOFTWARE	USED	TO	DEVELOP	AN	APPLICATION,
INSTALLATION	ERRORS,	SOFTWARE	AND	HARDWARE
COMPATIBILITY	PROBLEMS,	MALFUNCTIONS	OR	FAILURES	OF
ELECTRONIC	MONITORING	OR	CONTROL	DEVICES,	TRANSIENT
FAILURES	OF	ELECTRONIC	SYSTEMS	(HARDWARE	AND/OR
SOFTWARE),	UNANTICIPATED	USES	OR	MISUSES,	OR	ERRORS	ON
THE	PART	OF	THE	USER	OR	APPLICATIONS	DESIGNER	(ADVERSE
FACTORS	SUCH	AS	THESE	ARE	HEREAFTER	COLLECTIVELY
TERMED	"SYSTEM	FAILURES").	ANY	APPLICATION	WHERE	A
SYSTEM	FAILURE	WOULD	CREATE	A	RISK	OF	HARM	TO
PROPERTY	OR	PERSONS	(INCLUDING	THE	RISK	OF	BODILY
INJURY	AND	DEATH)	SHOULD	NOT	BE	RELIANT	SOLELY	UPON	ONE
FORM	OF	ELECTRONIC	SYSTEM	DUE	TO	THE	RISK	OF	SYSTEM
FAILURE.	TO	AVOID	DAMAGE,	INJURY,	OR	DEATH,	THE	USER	OR
APPLICATION	DESIGNER	MUST	TAKE	REASONABLY	PRUDENT
STEPS	TO	PROTECT	AGAINST	SYSTEM	FAILURES,	INCLUDING	BUT
NOT	LIMITED	TO	BACK-UP	OR	SHUT	DOWN	MECHANISMS.
BECAUSE	EACH	END-USER	SYSTEM	IS	CUSTOMIZED	AND
DIFFERS	FROM	NATIONAL	INSTRUMENTS'	TESTING	PLATFORMS
AND	BECAUSE	A	USER	OR	APPLICATION	DESIGNER	MAY	USE
NATIONAL	INSTRUMENTS	PRODUCTS	IN	COMBINATION	WITH
OTHER	PRODUCTS	IN	A	MANNER	NOT	EVALUATED	OR



CONTEMPLATED	BY	NATIONAL	INSTRUMENTS,	THE	USER	OR
APPLICATION	DESIGNER	IS	ULTIMATELY	RESPONSIBLE	FOR
VERIFYING	AND	VALIDATING	THE	SUITABILITY	OF	NATIONAL
INSTRUMENTS	PRODUCTS	WHENEVER	NATIONAL	INSTRUMENTS
PRODUCTS	ARE	INCORPORATED	IN	A	SYSTEM	OR	APPLICATION,
INCLUDING,	WITHOUT	LIMITATION,	THE	APPROPRIATE	DESIGN,
PROCESS	AND	SAFETY	LEVEL	OF	SUCH	SYSTEM	OR
APPLICATION.



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	National	Instruments	Web	site	at	ni.com
for	technical	support	and	professional	services:

Support—Online	technical	support	resources	at	ni.com/support
include	the	following:

Self-Help	Resources—For	answers	and	solutions,	visit	the
award-winning	National	Instruments	Web	site	for	software
drivers	and	updates,	a	searchable	KnowledgeBase,	product
manuals,	step-by-step	troubleshooting	wizards,	thousands	of
example	programs,	tutorials,	application	notes,	instrument
drivers,	and	so	on.
Free	Technical	Support—All	registered	users	receive	free
Basic	Service,	which	includes	access	to	hundreds	of
Applications	Engineers	worldwide	in	the	NI	Discussion
Forums	at	ni.com/forums.	National	Instruments	Applications
Engineers	make	sure	every	question	receives	an	answer.
For	information	about	other	technical	support	options	in	your
area,	visit	ni.com/services	or	contact	your	local	office	at
ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-paced
training,	eLearning	virtual	classrooms,	interactive	CDs,	and
Certification	program	information.	You	also	can	register	for
instructor-led,	hands-on	courses	at	locations	around	the	world.
System	Integration—If	you	have	time	constraints,	limited	in-house
technical	resources,	or	other	project	challenges,	National
Instruments	Alliance	Partner	members	can	help.	To	learn	more,
call	your	local	NI	office	or	visit	ni.com/alliance.

If	you	searched	ni.com	and	could	not	find	the	answers	you	need,	contact
your	local	office	or	NI	corporate	headquarters.	You	also	can	visit	the
Worldwide	Offices	section	of	ni.com/niglobal	to	access	the	branch	office
Web	sites,	which	provide	up-to-date	contact	information,	support	phone
numbers,	email	addresses,	and	current	events.
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Branch	Offices
Office Telephone	Number
Australia 1800	300	800

Austria 43	0	662	45	79	90	0

Belgium 32	0	2	757	00	20

Brazil 55	11	3262	3599

Canada 800	433	3488

China 86	21	6555	7838

Czech	Republic 420	224	235	774

Denmark 45	45	76	26	00

Finland 385	0	9	725	725	11

France 33	0	1	48	14	24	24

Germany 49	0	89	741	31	30

India 91	80	41190000

Israel 972	0	3	6393737

Italy 39	02	413091

Japan 81	3	5472	2970

Korea 82	02	3451	3400

Lebanon 961	0	1	33	28	28

Malaysia 1800	887710

Mexico 01	800	010	0793

Netherlands 31	0	348	433	466

New	Zealand 0800	553	322

Norway 47	0	66	90	76	60

Poland 48	22	3390150

Portugal 351	210	311	210

Russia 7	095	783	68	51

Singapore 1800	226	5886

Slovenia 386	3	425	4200

South	Africa 27	0	11	805	8197

Spain 34	91	640	0085

Sweden 46	0	8	587	895	00

Switzerland 41	56	200	51	51

Taiwan 886	02	2377	2222

Thailand 662	278	6777

United	Kingdom 44	0	1635	523545

United	States	(Corporate) 512	683	0100
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